VA I A % .
@uamsmamamﬂiﬂ'sumu HTML Mail

7 I A o Y A g 4
1. Upload Html TW@asuuiuindy ledndesms aindudanthivisada e asdwa Taely

Internet Explorer

€ “-" 2 bt/ v gt th/ v workshopPR/

File Edit View Favortes Tools Help
x Google | [+] * search - { B-|» & - Csignin- | x @Snagt B B
< Favorites | <4 g Bangkok University E-mail

. | @ Add Link |@worshopme. x| | i v B) v =) & v Pagev Safety~ Tooks~ @~

U AovUssguloniiwg 1 e1mMsUINAMAASAOLIWANS
UMONENALNSOINW Inenivasoaa

atins@u dusu 5 5u-
10gd 1,000 vnimiiu<

Workshop
dnnuosoluvmuus:

Done + Trusted sites | Protected Mode: Off 43 v H100% -




2. "lﬂﬁmyi View -> Source L‘ﬁﬂ@ Code Html

File Edit W=V Favorites Tools Help
x ch‘:gl] Tool 4 )earchv+li'}' Share' EI' » %Y (:,ISignIn' % & Snaglt @ [}
= Quick Tabs ™ Ctrl+ Q)
W 1
Explorer Bars pE—
88 '|'i kshop mw... XI | M- ~ [ = v Pagev Safetyv Tools~ (@~
GoTo 3
G
Stop Esc —
Refresh F5
Zoom 3
Text Size 2
Encoding 2
Style 4 =
Caret Browsing
Source
Security Report

International Website Address

Webpage Privacy Policy...

Full Screen

(USBnIASopd 19 WIUASH Clinique)

Displays the source (HTML] for this page. da v ®100% v

[ 1] 9
3. wzlnnguihaalumsg Code Himl Triidoniuy Edit - Select All tWoi@ondonumnaviug

th/th/news/workshopPR/ - Original Source

File | Edit | Format

|+ - - B
i Ehiet LlaandafA1mYiavia

< /titlex
t-Type"™ content="text/html; charset=utf-&8">

Find Ctrl+F
GoTe Ctrl+G

FE" leftmargin="0" topmargin="0" marginwidth="0" marginheight="0">
1" width="801" height="1134" border="0" cellpadding="0"

Select All Ctri+ A

cellspacing="0">
<Etr>
<td colspan="7">
<img .31'c="j.mages,‘index_{)1.jpg" width="800" height="144"

alt=""></td>
<td>
<imgy src="images/spacer.gif" width="1" height="144" alt=""></td>
</ftr>
<tr>
<td colspan="7">
<img src="images/index 02.7pg” width="800" height="164"




v 1
4. 9NUEeN Edit -> Copy IiBfinaBNYonIY

& httpﬁwww.bu.a_c.WneyrsMuﬂ:shopPR{ - Original Source

File Format

» z
Gty Ct1+C e Copy G2AMMYIMURA

Find Ctrl+F  heluau PRe/ticles>

GaTa CirleG 'Content-Type”™ content="text/html; charset=utf-8">

Select All Ctrl+ A FFFFF" leftmargin="0" topmargin="0" marginwidth="0" marginheight="0">
1" width="801" height="1134" border="0" cellpadding="0"

11
iz
i3
14
a5

cellspacing="0">
<Lrx
<td colspan="7">
<img 5:c="image5findex_01.jpg" width="800" height="144"
alt=""></od>
<td>
<img =rc="images/spacer.gif" widch="1" height="144" alt=""></td>
</tr>
<Lr>
<td colspan="7">
<img src="images/index 02.jpg" width="800" height="164"

m

— 2
5. i5on115un3y Notepad UL

| Accessories
D Calculator
Bl Command Prompt
88 Connect to a Metwork Projector
B2 Connect to a Projector
=i Getting Started
= Math Input Panel

| Notepad

9 v
6. MU Code Himl 71 1dasuu Notepad

File Format View Help

l Undo

Ctrl+Z -
- - &
o S ¥inAsInEaANM
Copy Ctrl+C ( ¥
Paste Ctrl+V NHAN copy U1ad
Delete Del
Notepad
Find... Ctrl+F
Find Next F3
Replace... Ctrl+H
Go To.. Ctrl+G
Select All Ctrl+ A
Time/Date F5




7. Code Html 929n21989UU Notepad tioansoud 1u 1dae 1

 File Edit Format View Help

hitml = = -
Rt daadu3:9n copy a3y Notepad  °

<title=workshop avelusu PR</title>

<meta http-equiv="Content-Type" content="text/html; charset=utf-8">

</head>

<hody bgcolor="#FFFFFF" leftmargin="0" topmargin="0" marginwidth="0" marginheight="C
<tahle id="Table_01" width="801" height="1134" border="0" celpadding="0" cellspacing=

<tr>
[l <td colspan="7">
<img src="images/index_01.jpg" width="800" height="144"
<td>
<img src="images/spacer.gif” width="1" height="144" alt=""_|
<ftr>
| <tr=
<td colspan="7">
<img src="images/index_02.jpg" width="800" height="164"
<td>
1 <img src="images/spacer.gif” width="1" height="164" alt=""
<ftr> tl
<ftr=
<td colspan="7"=
| <img src="images/index_03.jpg" width="800" height="266"
<td>
<img src="images/spacer.gif" width="1" height="266" alt="" (|
I <ftr=
<fr=

<td colspan="7">
<img src="images/index_04.jpg" width="800" height="489"
<td>

€ |y 1 | 3

Y o 1 @ Aa o & X Yy 9 .
8. Tdihmsastgeunusinialaniimauauaie <1mg src=

<body bgcolor="#FFFFFF" Ief”trnargin—"ﬂ" toprmargin="0" mrginwidth "0" marginheight="

<table id="Table_01" width="801" height="1134" border="0" cellpaddi c in U "
<trs 2 ﬂ%%iﬂl‘%jl Cnti Ii'll.m?%‘-:l%)lﬁ%;‘:l[% <img src

=td colg

<img src="images/index_01.jpg" width="800" height="144" alt=""=

src="images/spacer.gif” width="1" height="144" alt="">

<ftr=
<fr=

g’l @ { 4 <
9. nnulndulUnTdsunsu Mternet Explorer tie Copy Address Y0130 losdian

it View Favorites Tools Help

-+

N copy ussnaillidusnn

| & workshop mmﬂ?ﬁ‘hﬁ N"H"*"E‘ é_

x Google |

7 Favorites | 5 E| Bangkok University E-rnail

BB+ | & Email Marketer (E... | @ Add Link

dannsau
. 1wEd 1,0(



v H v
10. 910U Code Html 7118312190 Notepad wii14ion111 /image 0 9 UTTHAME

[] Untitled - Notepad
File Edit Format View Help

<html=

<head=>

=<title=workshop armiluau PR</title> i s ool
<meta http-equiv="Content-Type" content="text/html; charset=utf-g"> Al Taa copy aannussviand
</head>

=body bacolor="#FFFFFF" leftrmargin="0" topmargin="0" marginwidth="0" marginheight="0">
<table id="Table_01" width="801" height="1134" border="0" cellpadding="0" cellspacing=_2*

fA1ds  <img src=

<tr>
=<td colspan="7">
<img src=' wttp:!fwww.bu.ac.thfthfnewsfworkshoppngesfindex_ﬂl.jpg" width="800" height="144" alt=""» < /td>
<td>
<img src="pttpy//www.bu.ac.th/th/news/workshopP ges/spacer.gif” width="1" height="144" alt="">«/td>
<ftr=
<tr>

) H ' 9
1. ieud luasunnussianiiud Tdidonmy Bdit-> Select All iioidondonumianug

' ) Unfitied - Notepad I~ 4 .

|| File [Edit | Format View Help
Il <htr  Undo Ctrl+Z
<hez
<titl Cut ctlsX P
<me . H ntent="text/html; charset=utf-8">
</he Copy Ctrl+C
<hof "0" topmargin="0" marginwidth="0" rmarginl
<tah faste Chis¥ ight="1134" border="0" cellpadding="0" ce
| Delete Del
| L id s =
Find... Culer  c="hEEARATNAUATTARAD o
f Find Next 3 e="htN ARRARNS BRI WAl o
Replace... Ctrl+H
Go To... Ctrl+G
-“images/index_02.jpg" width="800" heigt
Select All Ctrl+&

9 1
12. MNU@enuY Edit > Copy ieAAaon Code Himl

r_j Untitled - Notepad (- 4 -
File Format View Help

Undo Ctrl+Z 3

= nin1a Copy
Cut Chrle X 5"im-—:25 index_10.jpg" width="24" height="65"
Copy (6 Plelly) - hittp://buca.bu.ac.th” target="_parent”s<img

<td !

el SN —irages/index_12.ing” width="0" height="65" 3
Delete Del

c="images/spacer.gif” width="1" height="58" alt=
Find... Ctrl+F
Find Next P o
Replace... e TN C="images/index_13.jpg" width="237" height="10
Go To.. & EACIIN = "images/spacer.gif” width="1" height="2" alt="
Select All Ctrl+A
Thime{Rate BB <= "images/index_14.jpa” width="250" height="8"

<Td>

<img src="images/index_15.jpa" width="245" height="8"




13. 1930 HTML Mail URL http://htmlmail.bu.ac.th NUUNTON Username LA Password

nsan Username Uaz
sm= BANGKOK UNIVERSITY

HTMLmail o PO
Username: sport
Password: sasen
Take Me to:  Home Page -

[¥] Remember my details
Login

£ 2008, All Rights Reserved.

14. s inguihaemshauaagl)

Home | My Account | Logodt | Help
L IBI.P[.N1GK()_II( UNIVERSITY = Time =6 am. 06 Sep 2010 - (GMT+7:0
MLma

:Ez Contact Lists 55' Contacts = -] Email Campaigns «

Home

ill; Contact Activity for the Last 7 Days

0 0 0 0 o 0 0 0 0 0 0 0 0 0 o 0

T T
Man Sun Sat Fri

_ Unconfirmed Contacts Confirmed Contacts . Unsubscribes . Bounces . Forwards

# IWould Like to... to Getting Started Links % Popular Help Articles

« \iew Contact Lists « Create Email Campaign
« Create a Contact List + Send an Email Campaign

+ View Custom Fields View Contacts
«  View Email Campaigns + Add a Contact



15. AANTIWY Create Email Campaign tVoddia 11

BANGK()_I‘( UNIVERSITY

Home | Py Account | Logout | Hem
HTMLma = am, 06 Sep -(GMT+

A Contact Lists » &) Contacts + (-] Email Campaigns +

Home

fll; Contact Activity for the Last 7 Days

C AN WE OO D oD

0 0 0 0 o 0 0 0 0 0 0 0 0 0 o 0

T T
Mon Sun Sat Fri

B Unconfirmed Contacts Confirmed Contacts [l Unsubscrices M sounces B rorwards

+# IWould Like to... Switch to Getting Started Links 4 Popular Help Articles

« View Contact Lists « |Create Email Campaign
« Create a Contact List « Send an Email Campaian \ - - .
i i adnuiadaLa vl

« View Contacts

+ Add s Contact

1 ] H 9
16. NTONFOIT0IDWANADINTAIN1IV0 Email Campaign Name 3101 UAAN Next

Create an Email Campaign
: - 1
Type a name for yoyyr cappga ﬂdlﬂﬂ'u“ﬂﬂﬂa_h‘:rmmmate below to get started. Click Ae

|L Next »> ] Cancel l

Asandalianaa1n158L

Email Campaign Details 3
Eamicl E-angeaen i workshop s Tusu PR L2 ]
* Email Campaign Format: e > : - 9
[HTML and Text (Recommended) =] @
Email Template: No Template
Custom Email Templates
Test Template
@.

Mext == ] [ Cancel




A 4 a a ¥
17. NIDNYDLTIDIVDIDINADNATY

Create an Email Campaign

|Jse the form below to create your email campaign. You can also chedk your email for spam keywords and see how it looks in different email dients.
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*HTML Content: @ Create content using the WYSIWYG editor below
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Follow this guide for tips on improving your subject lines.

@ Create content using the WYSIWYG editor below
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) Upload a file from my computer

©) Import a file from a web site d1hinsuTvas29dau  Code HTML dnada
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22. Lﬂﬂﬂiﬁ‘ﬂﬁﬂﬂl!ﬁjﬁlﬁﬂaﬂ‘ﬂﬂﬂ Save And Exit IN®N1N1T Save hlﬂﬁllaﬁf)f)ﬂ%’lﬂﬂWiVl’N’]u

aniia Save 11U
Create an Email Campaﬁiagn

Use the form below to create your email -:amp%u can also chedk your |

[ Save & Keep Editing ] [ Save And Exit ] Cancel

Email Campaign Details

* Email Subject: workshop sneTuasu PR

Follow this guide for tips on

23. @0y Email Campains -> View Email Campaigns 1N01013A529e0 1Az d94a

& Contact Lists ~ & Contacts ~

[] View Email Campaigns
View or edit your existing email
campaigns.
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113 !
o' Email Marketing Tip #15: Always inclu

View Email Campaigns

@ Create an Email Campaign
Create a new email campaign which you

Email campaigns are messages that are sent to can then send to contacts.

& Send an Email Campaign
[ Create an Email Campaign.. ] Send an existing email campaign to your

contact list.
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View Email Campaigns

Email campaigns are messages that are sent to your contacts, Use email campaigns to send newsletters, promotions or notification emails,

Create an Email Campaign. . ]

Choose an action El Results per page: |10 El Pages: (Page 1of 1) «|Badk |1 |Mext|=»

[F Hame &+ & Subject « & Created «+ & Last Sent Email Format Active Archive Action

[F] E4 workshop smaiusuPR workshop sixlusuPR 06 Sep 2010 NotSent  HTMLand Text & o« View Send Edit Copy Delete
1 2 3 4 5 6 7 8 9 10
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25. Idhmsnani)u Send odsdwa

View Email Campaigns

Email campaigns are messages that are sent to your contacts, Use email campaigns to send newsletters, promotions or notification emails.

Create an Email Campaign. . ]

Choose an action El Results per page: |10 EI Pages: (Page 1of 1) «|Badk |1 |Mext|=
[F Name &+ & Subject « & Created «+ & Last Sent Email Format Active Archive Action
[T] E3 workshop sasrlusuPR workshop avsilusiuPR 0& Sep 2010 NotSemt  HTMLand Text & (" 4 View Edit Copy Delete

A
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Send an Email Campaign

Before you can send an email campaign, please select which contact list(s) you want to send to.

Whe Do You Want te Send to?
1Want to: @ Send an emall o all contacts in the selected list(s) below
@ send an email to contacts who match my search criteria in the selected list(s) below
Select a Contact List(s)
Contact List: [F]F-List (1 active contact) @

‘test Group - Sprot (2 acf

aanldan list inasn1sdada

antfuadn Next
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' Want faster sending? Did you know that enabling cron (see documentation or contact your administrator) will allow you to schedule email ¢

Send an Email Campaign
Fill aut the form below to send an email campaign. If you are unsure what any of the advanced options mean then you can skip them.

@ This email campaign will be sent to approximately 2 contacts.

/i, This email campaign will be sent immediately. If you'd like the ability to schedule your email campaigns please contact your administrator.

[ hextz> [ canel |

Email Campaign Settings

* Send This Email Campaign: iwn;la’mu AT pﬁ%ﬁ“““]—'nﬁﬁiﬂﬁ“ B (2] E_Preview
* Send From This Name: am:ﬁl\qaﬂjanq’_ﬁ_ﬂﬁdi L

* Send From This Email Address: buca@bu.ac.th i]'u.lill_l-ih e

* Send Reply Emails to: buca@bu.ac.th ﬁmﬂl_l-ﬂi @
Advanced Settings (Optional)

Send Your Email as Multipart? Yes, send the email s multipart &

Track Open Rates for HTML Emails? es, track opening of HTML emails (2]

Track Links Clicked in this Email?? Yes, track alllinks in this email campaign @
= [ Yes, track my campaign using Google Analytics 2]
Embed Images as Attachments? [ Yes, embed images in the content &

diansandauansuudl Niada Next

[ mwext>> J|[ cancel ]
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o Want faster sending? Did you know that enabling cron (see documentation or contact your administrator) will allow you to schedule email ¢
Send an Email Campaign

Now button below.

To send your email campaign now, simply dick the Send My Emad Campaia

You're email campaign is called workshop e luawu PR
The subject line of your email campaign is workshop aneTuau PR

Your emal campaign will be sent to test Group - Sprot

It will be sent to a total of 2 contact(z)

Each email wil be about 3 KB in size, which totsls 6.9 KB for the entire send

If your email can't be sent it will be flagged on the ¥iew Email Campaigns page with an option to resend it

Send My Email G ign Now Cancel
|
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r B
Message from webpage ﬁ

*** Important, Please Read ™

A popup window will now appear threugh which your email campaign
will be sent. Please do not close the window. When your email
campaign has been sent the window will close automatically. If you
close the window then your emnail campaign won't be sent.

aamlu OK wWafiufiunisdq

| ok ||| cance |




